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March 2022: Phoenix 8.3.5, added entries for QC 16931, QC 18108, QC 18125, QC 18126, 

QC 18152, QC 18155, QC 18159, and QC 18172 
November 2021: Phoenix 8.3.4, added entries for QC 18053, QC 18110, QC 18111, and QC 

18119 

April 2021: Phoenix 8.3.3, added entries for QC 18081 and 18082, updated entry for 18061 

January 2021: Phoenix 8.3.2, added entries for QC 18054, 18060, 18061, 18062 

End of June 2020: Phoenix 8.3.1, added entry for QC 18043 

Mid June 2020: Phoenix 8.3 release  
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Installing Phoenix 8.3.5 

To install Phoenix 8.3.5:  

1. Manually uninstall any previous version of Phoenix using Windows > Settings >

Apps & features.

2. Manually uninstall any plugins that were installed separately from Phoenix using

Windows > Settings > Apps & features.

Folders for these separately installed plugins will remain in C:\Program Files
(x86)\Certara\Phoenix\application\Plugins after uninstalling Phoenix. Such plugins

include: Phoenix Integral Plugin, PKAssist, and PKSubmit.

3. Copy the license file (lservrc) from C:\Program Files

(x86)\Certara\Phoenix\application\Services\Licensing to a temporary location.

4. Remove all remaining folders and files under C:\Program Files (x86)\Certara.

5. Run the Phoenix 8.3.5 installer.

6. Copy your license file back to C:\Program Files

(x86)\Certara\Phoenix\application\Services\Licensing.

7. Reinstall the plugins that you uninstalled.

For PK Assist customers using Integral, the Phoenix Integral Plugin must be

reinstalled before PK Assist is reinstalled.

If you encounter any difficulties with these steps, please contact Certara Support. 

Note: The above instructions assume that the license is installed on the end user’s local 

machine. If Server license(s) are being used, Phoenix will need to be configured to use the 

Server license(s) after installation of this maintenance release. For instructions, please refer to 

the “Licensing of Phoenix software” section of the Getting Started Guide.pdf that was 

downloaded with the Phoenix installer. 

Phoenix Product Interoperability 

Phoenix 8.3.5 is compatible with the Integral 22.4.1 repository, which utilizes the 22.4.1 

version of the Phoenix Integral Plugin.  Phoenix 8.3.5 is also compatible with PKS 4.0.4. 

Phoenix can co-exist on the same workstation and run independently with Trial Simulator 2.3. 
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Certara® Contact Information 

Technical support 

Consult the software documentation to address questions.  If further assistance is needed, 

contact Certara Support through e-mail or our support portal. 

E-mail: support@certara.com  

Web: https://certaracommunity.force.com/support/s/ 

For the most efficient service, e-mail a complete description of the problem, including copies 

of the input data. 

User forum. 

Get tips and discuss Certara software with other users: 

https://support.certara.com/forums 

Phoenix 8.3.5 Updates 

A checksum and a test unzip are now done when Phoenix projects are saved as zip files 

(QC 16931):  If the checksum or the test unzip fails, the projects are resaved.  This may 

prevent some cases of project files becoming corrupted. 

Autobackup feature implemented to aid in recovering from corrupt projects (QC 

18108):  When saving a project, Phoenix now creates a backup project file (with an 
extension of .phxbackup) in the same directory.  This provides a recent “checkpoint” 
from which most of the work can be recovered in the event that a project becomes 

corrupt.  Note that there is only one backup file maintained for a project, i.e., 
subsequent save operations overwrite the project’s backup file.  

R script changes are now retained when using “Start Development Environment” within 

the R Shell object (QC 18125):  When using Phoenix 8.3.3, once changes to the script were 

made, saved back to disc, and R-Studio was exited, re-loading the script in Phoenix showed 

none of the changes.  With Phoenix 8.3.5, the edits are now visible upon re-loading in 

Phoenix. 

Saving an un-executed NCA object created with Phoenix 8.3.x outside of Phoenix, then 

reloading the project and executing it, no longer generates an error (QC 18126) 

An issue where using Phoenix 8.3 to execute an NCA with a large number of profiles 

resulted in a “Phoenix has stopped working” error due to a stack overflow has been 

fixed (QC 18152/CRM 215821). 

Reporter object no longer wraps data in Table cells differently than Phoenix 8.1 (QC 

18155):  A different padding constant was implemented in Phoenix 8.3 but has been reverted 

to the 0.38 inches padding width value that was used in Phoenix 8.1.  

mailto:support@certara.com?subject=Phoenix%20support
https://certaracommunity.force.com/support/s/
https://support.certara.com/forums/
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An NCA with many profiles no longer fails to run when executed while viewing a panel 

with mapped data (QC 18159).  

IWRES and epsilon shrinkage are now calculated correctly for all observe() statements 

in a model (QC 18172):  Previously, the IWRES and epsilon shrinkage calculation was only 
correct for the first observed() variable listed in the model. Now, calculations are correct for 

all observe() variables that appear after the first observe() statement in the PML model.  

Phoenix 8.3.4 Updates 

Installation of this maintenance release (Phoenix 8.3.4) is necessary to prevent erroneous 

detection of Certara executables as “unsigned” after certificate replacement, and is mandatory 

for all Phoenix NLME and Phoenix WinNonlin customers. 

Phoenix Installation test case in Validation Suite runs successfully with installation of 

PKSubmit 1.1 plugin is installed (QC 18053): Failure of the Phoenix Installation test case 

was actually fixed in the Phoenix 8.3.2 release, but inadvertently remained listed as a Known 

Issue. 

NCA no longer omits profile from execution with incorrect dosing warning (QC 18110):  

Previously, when using an external Dosing worksheet and the Dosing Defined option, with 

multiple doing routes in the same dataset, it was possible for one or more profiles to be 

incorrectly missing from NCA results, with a warning message “Dosing Type not Defined.”  

This issue is resolved in Phoenix 8.3.4. 

An issue where NCA would fail to execute and give a pop-up message “one or more 

errors” or unhandled error has been resolved (QC 18111).   

An issue where Phoenix 8.3.x freezes has been resolved (QC 18119):  In varying 

circumstances, freezes were reported to occur when using Phoenix 8.3, 8.3.1, 8.3.2, or 8.3.3.  
The problem was related to the Rich Text control being created in the non-GUI thread, which 

caused a deadlock. 

Phoenix 8.3.3 Updates 

Phoenix installer now supports SCCM (QC 18082):  Phoenix 8.3.3 has been tested using 

Certara’s internal SCCM system and several customers’ SCCM system. 

An issue where Phoenix would freeze up when idle and needed to be closed from the 
Task Manager has been fixed (QC 18081):  There was a rare condition involving the 

memory manager tool that, in certain circumstances, caused Phoenix to freeze. This issue has 

been resolved in Phoenix 8.3.3. 
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Phoenix 8.3.2 Updates 

Workflow execution speed no longer slower than 8.2 or 8.1 (QC 18054):  In Phoenix 8.3, a 

change was made to update the icon of a workflow item when its parent was being executed; 

this change caused a slower execution speed while providing little information.  The Phoenix 

8.2 behavior has been restored.  

The Certara Integral 1.1.1 Plugin no longer breaks ggquickeda (QC 18060):  Installing 

the Certara Integral 1.1.1 Plugin for Phoenix laid down a new version of the DotNetBrowser 
control, as required by the Integral plugin.  This version of the DotNetBrowser, however, was 

not compatible with the plugin used for ggquickeda.  In Phoenix 8.3.2, the ggquickeda plugin 

has been updated to use the newer version of the DotNetBrowser control in order to fix this 

issue.  

Issue with Validation Suite failing due to projects sometimes not loading has been fixed 

(QC 18061).    

Objects can now be renamed after JMS execution (QC 18062):  JMS (Job Management 

System) enables users to execute Phoenix jobs in the background of the local machine or 

remotely on another machine.  A change was introduced in Phoenix 8.0 that prohibited 

renaming a project after it had been executed using JMS.  In Phoenix 8.3.2, users are able to 

rename the project, restoring the behavior prior to Phoenix 8.0. Note that this change only 

impacts the ability to rename the project and not the execution or results of the project.  

Phoenix 8.3.1 Updates 

An issue reported for Phoenix 8.3, where running the Data Wizard’s Filter function in a 
native Chinese environment generated errors, has been fixed in Phoenix 8.3.1 (QC 

18043). 

Phoenix 8.3 

What’s New 
Data Tools and Plots 

Framework 

IVIVC 

NLME 
PML 

Reporter 

Tools  
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Data Tools and Plots 

Charting 

Add annotations to plots (QC 1648):  Add one or more annotations to a plot using the 

Annotations tab.  Drag and drop the annotation anywhere within the graph area.  

New “Start axis at 0” option (QC 2974):  A new Start axis at 0 option is now available on 

the Axis Options – Content tab.  When checked, this option forces the axis numbering to start 
at zero, regardless of the data values.  The option is available for a linearly scaled, continuous 

axis, with either auto-scale option selected. 

Display individual data points on a Box plot (QC 11454):  A Show All Data Points 

checkbox is now available in the Graph Content tab of a Box plot.  

Control the appearance of error bars in XY Plots (QC 12844):  The following options are 

now available on the Appearance tab for error bars: 

Center Marker Size:  Sets the size of the marker used to indicate the center point of the 

error bar 

Cap Width:  Changes the width of the top and bottom bars 

Line Weight:  Controls the thickness of the error bar lines.  

 

Group names now appear as the X-axis label (QC 16303):  As a result, the Include 

Column Names in Tick Labels when Grouping checkbox is no longer needed and has been 

removed. 

“Collapse Sparse Latticing” option is now on by default for NLME plots “Ind DV, 

IPRED vs IVAR Lattice” and “Ind DV, IPRED vs TAD Lattice” in order to remove 

empty plots (QC 16377). 

Modify the font of diagonal labels in a Scatter Plot Matrix (QC 17678):  A Display 

Diagonal Labels checkbox is available in the Graphs Options – Appearance tab for Scatter 

Plot Matrices.  Checking this box adds a Change Font button to the tab for adjusting the font 

properties of the diagonal labels. 
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“Bring to Front” option for regression lines is now functioning properly (QC 17938):  In 
Phoenix 8.2, the regression line would not display in front of the points, even when the Bring 

to Front checkbox was turned on.  This issue is fixed in Phoenix 8.3. 

A blank cell in a data label column now results in a blank label for the associated 
observation (QC 17961):  If a column mapped for use as the data labels has blank cells, the 

data label for the associated observation is also blank.  Previously, Phoenix would substitute 

the y-value if the data label was blank.  

Colors can now be set for “Each Group by Color” option (QC 17962):   In Phoenix 8.3, 

changing the marker or line color of an individual member of a group applies the color change 

to all individual members of the same group when the Each Group by Color option is 

checked. 

Data Wizard 

F distribution function added in Data Wizard Transformations Custom Functions (QC 

13434):  The Finv custom function is now available in the Data Wizard and calculates the 
quantile of F-distribution, returning the absolute value in the output.  The format is: Finv (p, 

df1, df2). 

ggquickeda 

Phoenix 8.3 now provides access to the open-source plotting tool ggquickeda (QC 17971):  

The new ggquickeda object (New > External Software > ggquickeda) provides access to the 

ggquickeda R shiny application, which is an interface to ggplot2/table1.  The application 

enables quick exploration of data to detect trends on the fly.  This tool creates scatter, dot, box, 

and bar plots, as well as histograms, densities, and summary statistics tables. 

Framework 

Menus 

Insert menu redesigned (QC 17036):  Phoenix 8.3 includes a reorganized operational object 

list on the Insert menu and right-click menu to facilitate locating a desired object.  Below is a 

list of changes. 

Phoenix 8.2 Phoenix 8.3 

Data Renamed Data Management 

NCA and Toolbox Removed and content split into two menus: 

NonCompartmental Analysis > 

Contains NCA, Nonparametric 
Superposition, and Semicompartmental 

Modeling 

Computational Tools > 

Contains Bioequivalence, Convolution, 

Crossover, Deconvolution, Descriptive 

Statistics, and Linear Mixed Effects 

Phoenix Modeling Renamed Modeling 
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Phoenix Model Moved under Modeling >  

Renamed Maximum Likelihood Models 

Phoenix Model Comparer Moved under Modeling >  

Renamed Maximum Likelihood Model Comparer 

WNL5 Classic Modeling Moved under Modeling >  

Renamed Least-Squares Regression Models 

WNL ASCII Model Renamed User ASCII Model 

Reporter Moved under Reporting > 

Table Moved under Reporting > 

NONMEM Shell, NONMEM 

Comparer, PsN Shell, R 
Script, SAS Shell, SigmaPlot 

Shell 

Moved under External Software >  

IVIVC 

Data Labels are off by default in IVIVC Levy Plots (QC 18024).  

NLME 

View PRED values in tables and at any time point (QC 16879):  To obtain population 

predicted values, type the following in the Variables field on the Run Options tab, Simple 

mode, Tables section: 
    Pred(name of observed variable)  

Binning is now available in Predictive Check for X-variable data when Y is categorical 

or count (QC 17488).  

Grouping dependent (Y) values is now possible for categorical or count observations in 

Predicted Check (QC 17554):  Choose the Right boundaries option from the new 

Grouping Y values menu in the tabs corresponding to a categorical/count observed variable 

to specify how values are grouped.  When this option is chosen, a Boundaries field is 

available for entering a list of Y values to define the right boundaries of grouping intervals.  

Select categorical covariates for stratification for each dependent variable (QC 17559):   

Menus for selecting up to three categorical covariates for stratification of a specific dependent 

variable are available in the “Predictive Check Options” section in the Run Options tab.  

Initial estimates graph is no longer blank for non-time-varying parameters (QC 17964):  
In Phoenix 8.3, the graph is a horizontal line for the value of the parameter/covariate vs. time 

for non-time-varying parameters/covariates. 

Engines 

New ODE solver for non-stiff cases (QC 15778):  The Max ODE selection now includes the 

option non-stiff DOPRI5.  The non-stiff option, available in prior versions, is now referred to 

as non-stiff DVERK.  The new DOPRI5 option has the conventional RTOL – ATOL (relative 
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and absolute tolerances) inputs found in all of the other solvers except the DVERK solver, 

which, on the other hand, only has a single combined tolerance.   

Steady state analysis capability is added for models involving the delayInfCpt statements 

(QC 17371). 

New algorithm implemented for the gamma distributed delay function is able to handle 

more complex problems and with increased speed (QC 17372).   

A new “Output PRED” checkbox is available when prediction correction is applied (QC 

17474):  When checked, the population prediction results are included in the PredCheckAll 

worksheet as a replicate “-1”.  When unchecked, the output worksheet starts with the results of 

replicate zero.  

User Interface 

New columns in Predictive Check output worksheets report bin boundaries (QC 16216):   

The new Bin_Min and Bin_Max columns provide the minimum and maximum bin 

boundaries, respectively.  These new columns are now available in the 

PredCheck_BQLFraction, PredCheck_Cat_ObsQ, PredCheck_Cat_SimQ, 

PredCheck_ObsQ_SimQCI and PredCheck_SimQ worksheets.   

Simulation mode now has additional table options (QC 17412):  Additional table options 

are now available when setting up a simulation run.  These new options are include: 

Keep source structure to keep the number of rows appearing in the simulation table for 

each replicate to be the same as the number of rows in the input datasets.  

When covr set to specify any covariates to include 

When dose to specify a dose point to include (e.g., Aa or A1)  

When observe to specify any observed variable to include (e.g., CObs or EObs)  

Separate results worksheets and plots are now available for Predictive Check 

categorical/count data (QC 17524):  Worksheets and plots that contain the categorical or 

count data results will have “Cat” or “Categorical” in the name.  For example, 

Observations_Categorical, PredCheck_Cat_ObsQ, PredCheck_Cat_SimQ, and Pop 

PredCheckCat ObsQ_SimQ. 

New BQL fraction worksheet and plot output when BQL Fraction mode is used (QC 

17525):  The PredCheck_BQLFraction worksheet reports the stratum-bins, minimum and 
maximum of the bin boundaries, IVAR values, observed and predicted fractions, observation 

name, and observed quantile levels.  The “PredCheck BQLFraction” plot data comes from this 

worksheet. 

Simulation Table option is available in Predictive Check mode (QC 17736).    

For Bootstrap, the initial estimates run is no longer performed by default, but is 
available as a new option (QC 17665):  To preserve any setup work done by the user, the 

default mode for Bootstrap no longer performs an initial estimates run.  When Bootstrap is 

selected as the Run Mode, a new Estimate initial model parameters? checkbox becomes 

available to allow users to choose if they want to perform this initial estimates run.  
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PML 

The delayInfCpt statement and delay function are extended to include Weibull and 

Inverse Gaussian distributions (QC 17355):  Use the new dist option in the 

delayInfCpt statement or the delay function to specify the distribution of the delay time as 

either Gamma, Weibull, or InverseGaussian.  

Reporter 

Number of levels for caption numbering increased to permit multiple levels (QC 12750):  

Previously, the Major Index field only allowed entry of a single digit.  Phoenix 8.3 allows 

entering multiple numbers, separated by periods, to increase the level of the headings shown 
in the report.  For example, if the user enters “16.2” in the Major Index field, then the table 

and figure caption numbers will be 16.2.1, 16.2.2, 16.2.3, etc.  

Reporter supports importing of Word template files loaded from PKS (QC 16222).  

Date and time stamp available for tables and figures as a global footnote (QC 17941):  

Options for adding global footnotes for Source, Object Name, and Date and Time to 
Worksheets/Tables, Figures, and Text results in the report are on the Options tab.  The Date 

and Time option adds the date and time of the object execution that generated the result to the 

footnote.  For objects that are not the result of an execution, such as data in the Data folder, 

the “last saved” date and time of the worksheet (such as what is shown on the Information tab) 

is included in the footnote.  (Note that the Source and Object Name checkboxes located in 
the Footer settings dialogs for Tables, Figures, and Text objects have been removed since they 

are now available in the Options tab.) 

New “Disable all automatic numbering of Tables, Figures, and Listings” checkbox on the 

Options tab allows turning on/off automatic numbering with a single click (QC 17942).   

Control the number of lattice rows on a page (QC 17943):  A new Rows per page option 

for controlling the number of rows on a page for a lattice of figures is available in the Figure 
tab of the options dialog.  Select the number of desired rows to display on the page or select 

To fit to display as many rows as possible on the page (this is the Phoenix 8.2 behavior).  

Subscripts, superscripts, and symbols such as “<” are now retained in the report (QC 

17944, QC 17945).   

Contextual footnotes list has a new Match column indicating the search type to perform 

when looking for the abbreviation:  Entire or Partial (QC 17954).  

Tools 

NCA 

Log trapezoidal methods calculating the AUC are now available for selection in Sparse 

Sampling (QC 17931):  Previously, only the two linear methods of computing the AUC were 

available for selection with the Sparse Sampling option.  The log methods were excluded 

because SE for AUC computations depend on AUC being a linear combination of the mean 
concentrations.  In Phoenix 8.3, the two log methods are available for selection to allow users 
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to get all the parameters for the mean concentration curve.  However, selecting either log 
method does not output the SE_AUClast and SE_AUCall parameters, but does output 

SE_Cmax. 

Tables 

Editing option for titles, column headers, table body, statistics, and footers is available, 

in addition to adding and removing (QC 11607). 

 

 

 

Issues Corrected 
Data Tools and Plots 

External Software  

Framework 

IVIVC 
NLME 

Reporter 

Tools 

Validation Suite 

Data Tools and Plots 

Charting 

An issue involving an unhandled exception occurring when trying to edit the legend of a 

plot involving group variables is fixed in Phoenix 8.3 (QC 17804). 

An issue where attributes (graph names, marker/line styles and colors) of two graphs 

switched in a copy of the plot or when using object settings is fixed (QC 17829).  

In an XY Plot with zero or negative values and a y-axis that is log-scaled, only the upper 

error bars are shown now so that the lower error bars are not clipped at the x-axis (QC 

17833/CRM 169645):  This issue was actually fixed in Phoenix 8.2, however it inadvertently 

remained listed in the release notes as a Known Issue. 

An issue where a custom ordering of columns for a box plot was ignored is resolved in 

Phoenix 8.3 (QC 17939). 

Regression lines are drawn on the correct plot when “Collapsed Chart Latticing” option 

is used (QC 17957):  In Phoenix 8.2, when the Collapsed Chart Latticing option was on, the 
program did not take into account the removal of empty plots.  As a result, the regression line 

calculated for one plot could appear on a different plot or be missing because an empty plot 

was at that position originally.  This issue is resolved in Phoenix 8.3.  

An issue involving a missing overlaid plot title in the Table layout options is resolved 

(QC 17969). 
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Column Transformation 

Custom column transformation Adjacent option now functions as expected (QC 11728):  

For custom transformations, the Adjacent option placed the new column at the end of the 

worksheet.  This issue is fixed in Phoenix 8.3. 

When a DF value for the Column Transformation tinv is negative or zero, the output is 

now null (QC 13876):  Previously, when an invalid DF (i.e., a negative or zero DF) was 

entered for the custom function tinv (t-inverse), the output was incorrectly reported as one.  

Data Wizard 

A reported issue where unexpected spaces in Custom Transformation formulas caused 

the mapping panel to display improperly is obsolete (QC 14167):  Spaces are still not 

permitted between the function name and the left parenthesis, but there is a clear error 

message displayed. 

An unhandled exception when using the Data Wizard to create an empty column with no 

column header and then selecting it is fixed in Phoenix 8.3 (QC 17922).   

Descriptive Stats 

A reported issue where the statistic name change from “CV% Geometric Mean” to 

“Geometric CV%” caused backward compatibility to not be maintained and the column 

became unmapped in referencing objects is obsolete (QC 17436):  This issue applies to 

versions of Phoenix that are no longer supported.  

External Software 

SAS 

Reordering of columns no longer causes mismatch of data upon export (QC 17921):   This 

issue occurred when the dataset being exported using SAS had originated from the Data 
Wizard and had Sort Keys.  When SAS column reorder settings were then applied, the 

exported results would contain mismatched data.  In Phoenix 8.3, the original order of a 

dataset will be overridden by any SAS column reorder settings. 

Framework 

Data 

After pasting data into a Phoenix worksheet (or deleting rows),  the focus remains at the 

end of the pasted data (QC 16340/CRM 159195):  Previously, the focus jumped to the top 

of the worksheet and the user would then have to scroll down to the bottom to paste more data. 

File I/O - Excel 

Data imported from Excel workbooks is now imported/displayed correctly (QC 17970):  

An issue was reported where Excel sheets (.xls, .xlsx) having columns with both text and 

numeric data were not imported correctly as a Phoenix worksheet.  This was due to the 

program not looking at enough rows in Excel files to determine the column type.  Phoenix 8.3 

now uses the first 100 rows of an Excel file to determine the column type.  
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Object Browser 

Upstream Data Wizards can no longer be deleted while executing Phoenix (QC 17819). 

Plugins 

Error when adding a default save option in PKS preferences is fixed (QC 17914):  This 

issue was caused by the presence of duplicate Plotting objects and Next Generation Plot 

objects in Phoenix 8.2.  With the removal of the Next Generation Plot objects in Phoenix 8.3, 

the error no longer occurs. 

Printing 

An issue where a wide Table becomes truncated is due to an IE print limitation (QC 

5432):  Printing tables comprised of wide data directly from Phoenix can result in truncated 
tables in the printed output.  This is an Internet Explorer print limitation, not a defect within 

Phoenix, so this issue has been closed as “Not a bug.”  Users can copy the table from the 

Results tab to the Tables folder and use Edit in Excel to format the table as desired. 

R 

An issue where data source inputs remained when data source inputs were published 

using decorated attach statements that were later removed is not reproducible (QC 

11839):  This issue was reported as a Known Issue in Phoenix 8.2, but could not be 

reproduced in Phoenix 8.3 and has been closed. 

IVIVC 

Correct version of IVIVC is reported in the Core Output in Phoenix 8.3 (QC 18007):  In 

Phoenix 8.1 and 8.2, the IVIVC Core Output reported the version as “IVIVC Toolkit 8.0”.  

Convolution 

Convolution now generates results even if the source data set includes blank or text 

values (QC 10523):  Previously, Convolution would not generate results for profiles that had 

any non-numeric Cumulative_Input values.  This issue is resolved in Phoenix 8.3.  

Convolution no longer fails execution when Time column is declared as type Text (QC 

17732):  The input data column mapped as Time is now sorted numerically, even if the type is 

set as Text.  

Deconvolution 

In Deconvolution, Cumulative Rates Plot is renamed to Cumulative Input Plot (QC 

2441):  When using an existing project from Phoenix 8.2 or earlier, select Reset Existing 

Plots on the Plots tab for plot names to update on re-execution in Phoenix 8.3. 

Levy Plot 

Levy Plot – The IVIVC output sometimes appeared out-of-date after executing (QC 

11609):  This issue is not reproducible in Phoenix 8.3 and has been closed.  
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Wagner-Nelson & Loo-Riegelman  

Settings are now included in Settings text output and in History (QC 10348). 

Workflow 

Prediction and Validation Errors now match the Reference output (QC 14353):  If 

columns mapped to IVIVC time mappings (i.e., InVitro Time, InVivo Independent, and 

Prediction Time) had type Text, these columns were being sorted as text rather than 

numerically when performing Validation and Prediction, which then caused errors in the 

internal interpolation routine.  Input data columns mapped to IVIVC time mappings are now 

sorted numerically, even if the type is set as Text.  

IVIVC Correlation and Pred Corr Sim Observed Y and Predicted Y vs X plots now have 

the correct Y-axis label of Fabs (QC 17826/CRM 00169719):  An issue was reported where 
the Y-axis was labeled Cp when the buttons on the Options tabs of the IVIVC Workflow 

(Build Correlation, Validate Correlation, and Predict PK) were used, but was correctly 

labeled Fabs when the Execute icon in the Phoenix toolbar was used.  In Phoenix 8.3, the Y 

axis is labeled “Fabs” for Build Correlation and Predict PK, regardless of the method of 

execution.  The issue remains for Validate Correlation, however, and is included in the list of 

Known Issues. 

NLME 

If a dose and a categorical observation of zero appear together on the same line in the 

input dataset, then the observation is treated as real data and is not ignored (unless there 

is an explicit MDV entry of one on the line, in which case the observation is always 

ignored) (QC 17717):  Previously, in such case, the observation was ignored unless there was 

an explicit MDV entry of zero on the line.  

NLME temp file location can now be specified to avoid Anti-Virus applications problems 

(QC 17818):  An issue was reported that the default temporary file location for NLME runs 

caused problems with Anti-Virus applications and the location could not be changed by the 

user.  In Phoenix 8.3, the Preferences dialog includes an NLME page in which the user can set 

the temporary file location.  

Multicore Bootstrap – Core Output tab information now contains information for all 
replicates (QC 17926):  Previously, the multicore mode only output the results obtained for 

the last bootstrapping sample with “No output found” appearing at the very beginning.  In 

Phoenix 8.3, results for all the bootstrapping samples are reported, which is consistent with the 

output when using local, and local MPI modes. 

NLME no longer freezes on the grid with bootstrap run mode (QC 17983). 

Engines 

An issue where different -2LL values for the QRPEM engine were being reported in the 

Job Viewer and in the Overall results worksheet has been fixed (QC 17968):  With some 

models, the Overall results worksheet would have an incorrect value for -2LL when the 

optimization was performed using the QRPEM engine.  However, the Job Viewer would 

display the correct value.  In Phoenix 8.3, the correct value is now reported in both locations.  
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Intermediate file no longer remains locked during Stepwise covariate search + MPI for 
the QRPEM engine (QC 17987):  In a Covariate Search run, if the QRPEM engine is used,  

some temporary files could remain locked after the previous run completed and not be deleted.  

The issue was observed for MPI runs on Windows only.  It is fixed in Phoenix 8.3. 

Grid Computing 

NLME license no longer fails on grid (QC 17982):  When a job was sent from a Windows 

client to a remote host, NLME could not generate the model and start due to time out of sync.  

This issue is fixed in Phoenix 8.3. 

User Interface 

The maximum number of Sort and ID columns, which is five, is now checked in the user 

interface, thereby preventing missing columns in the output (QC 7905).  

If SS or ADDL input is specified, and if input column names are given, verification now 

checks if the column names match those in the input data set (QC 8805):  If column 
names do not match, verification now fails.  Previously, there was no warning, resulting in 

potentially undefined behavior as NA values are used.  

An issue where opening a Phoenix 8.1 model simulation project with zeroed random 
effects in Phoenix 8.2 led to an unusable NLME object has been resolved (QC 17948):   In 

Phoenix 8.1 and earlier, zeroed random effects were treated as “1” in built-in and graphical 

mode.  In Phoenix 8.2, this behavior was changed such that a diagonal random effect found to 

be “0” was excluded from any estimation/simulation (zero rule).  A case was reported where a 

user zeroed the random effects and then excluded them by freezing the fixed effects (which is 
an unusual method).  Since the random effects are excluded when fixed effects are frozen in 

built-in mode but the random effects are still present inside the structure, NLME would try to 

exclude them again according to the zero rule, causing an unusable NLME object.  This issue 

has been resolved such that an NLME object with zeroed random effects that are excluded 

with frozen thetas works without error. 

Column existence is now checked in the Dosing worksheet as well as in the Main 

worksheet when a column is selected in ADDL input options (QC 17949):  In Phoenix 8.2, 

when an amount column was specified, only the main worksheet was being checked for the 
existence of that column.  In Phoenix 8.3, both worksheets are checked to determine if the 

column exists. 

Reporter 

Subject tags in captions are now working correctly for NCA Plots (QC 17946):  In 

Phoenix 8.2, the #formulation# and #subject# tags did not appear separately for each subject 

and formulation, as they had in the prior release.  Instead, all subjects were listed in the 

caption.  In Phoenix 8.3, only the subject that corresponds to a particular page in the plot is 

shown in the caption on that page.  

An issue where not all of the partial-match footnotes were being added to the table is 

fixed in Phoenix 8.3 (QC 17953).  
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Tools 

Bioequivalence 

Table or other object using Bioequivalence output as the source is now updated correctly 

when the Bioequivalence object is re-executed (QC 7724):  Previously, re-executing a 
Bioequivalence object created new instances of the Ratio output worksheets, rather than 

simply updating the existing instances.  In Phoenix 8.3, re-execution of the Bioequivalence 

object updates the existing worksheets. 

In a Bioequivalence Object, copy/paste, move-to-new-workflow, or use a template, and 

then map source will reset the Fixed model to the default (QC 9641):   In earlier releases, 

mapping a new input dataset to a Bioequivalence object, a copy of a Bioequivalence object, or 

a Bioequivalence object loaded from a template, would cause the model specification to be 

reset to the default model, even if the mapped columns were identical for the new data.  Any 
model specifications made by the user to the default model were lost.  In Phoenix 8.3, if the 

mappings are identical for the new mapped dataset, then the model is not updated.  If the user 

makes any mapping changes other than mapping an additional dependent variable, or if 

automatic mappings occur due to different column names in the dataset matching the mapping 

contexts, then the model is rebuilt to the default model since the existing model will not be 
valid anymore.  (TIP:  Note that therefore the user can reset to the default model at any time 

by unmapping and remapping a column.) 

BQL 

The “Carry over concentration column” checkbox is now checked by default (QC 7624).  

NCA 

Performance issues when navigating between profiles in the Slopes tab are resolved (QC 

17438/CRM 00164916, 00168442). 

NCA object settings created in Phoenix 8.1 or older versions are fully supported in 8.3 

(QC 17933):  In Phoenix 8.2, when setting up the dosing for NCA using an internal 

worksheet, if object settings created in Phoenix 8.1 or older were applied or if a default object 

settings file was in use, the error “Unable to construct internal source” was displayed.  This 

issue is fixed in Phoenix 8.3. 

An issue where the format of the Final Parameters worksheet could not be changed is 

resolved (QC 17975). 

Correct Tau value is used in NCA user-defined parameter calculation (QC 17985):  In 

Phoenix 8.0 or later, a user-defined parameter can be defined in NCA and dosing variables 

such as Dose or Tau can be used in its expression.  Due to incorrect merging of the 
worksheets, the wrong value for Tau was used in the calculation.  The merging issue is fixed 

in Phoenix 8.3 and the correct Tau value is now used in NCA user-defined parameter 

calculations. 

Tables 

An issue with empty cells not being handled properly in French Operating Systems is 

resolved (QC 17464):  On English Operating Systems, Phoenix automatically replaces 'NaN' 
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(Not a Number) with a blank cell.  This was not happening for other languages, which led to 
an inability to identify and remove empty cells.  Phoenix 8.3 properly handles empty cells in 

all supported languages. 

Validation Suite 

Phoenix Model validation tests no longer fail when Phoenix is installed on a volume with 

8dot3 policy disabled (QC 17958).  

 


